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Introduction 

Mobiscope software consists of two components: the desktop part and the client module. 

 
The desktop part (Mobiscope Desktop) should be installed on your computer. 

 
The client module should be installed on your mobile device. 

To view your web and network cameras on your computer through your handheld, you should 
install both these components. 

Appendix A provides the information about downloading and installation of Mobiscope Client on 
your mobile device. In every Mobiscope Client you will also find directions on how to work with a 
mobile client. 

1. Installing Mobiscope Desktop on a computer 

Mobiscope Desktop allows you to view up to four cameras (both ordinary web cameras and 
network cameras) on your mobile device. You should install the desktop part of Mobiscope on all 
computers with cameras which you're going to use. Run the installation executable file 
mobiscope_desktop.exe and follow the instructions of the installation wizard to completely 
install the product. 

You can download this file from our site: www.mobiscope.com/download

 

Note:

 

For correct work of the desktop, you should install this software with the account having 
administrator privileges on the local computer. 

I f your computer isn't registered in Mobiscope Online Service, you should fill the registration form 
while installing the Desktop. 

 

Note: Please specify existing email address in registration form exactly. You will receive automatic 
notification about registration to this email address. You should confirm or cancel your registration in 
'Mobiscope Desktop', by choosing one of the web links in this email. 

In the Mobiscope Desktop each registered computer has a special computer number assigned at 
registration in the service. I f connection to Mobiscope Online Service has established and the 
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registration was completed successfully, the unique computer number will be assigned to your 
computer. You will see this number in the desktop with title 'Mobiscope computer number'. 
If the connection wasn t successful please verify proxy settings. 

The Mobiscope Desktop connects to Mobiscope Online Service as usual Web browser (using HTTP 
requests through port 80) and it doesn't require direct access to the computer or other special router 
settings. But if in your local network the proxy server is used, you should specify proxy settings. For that, go 
to the File menu, select Options -Connection and enter all required information. Details about proxy 
settings, you can get to know from your network administrator. 

After registration you should add a password which you will use to access your computer with 
cameras connected to it. 

 

After the installation is successfully completed, start the Mobiscope Desktop application. You 
can find this item in Windows menu Start 

 

Programs 

 

Mobiscope. 

In order to start working with Mobiscope Desktop, you should have the Mobiscope Desktop to be 
running on your computer (it should have 'Online' status in the Desktop). 

 

http://www.shapeservices.com


© 2007-2009, SHAPE Services 
www.shapeservices.com

 

5

 
Note:

 
If you have problems with your web camera, please first check if it is connected to the computer 

properly and that it is not used by the other application. I f you have problems with your netcam please 
check settings of the camera according to its manual. 

Windows Firewall window may occur at first launch of Mobiscope. You should press the button 
Unblock to allow Mobiscope Desktop direct access. This will speed up Mobiscope performance. I f 
you select Keep blocking Mobiscope will also work. 

2. Viewing cameras and recordings on the desktop 

After you install both Mobiscope Desktop and Mobiscope Client you can start viewing your 
cameras. You can select up to four cameras that you want to work with. 

I f you also want to view a network camera you should add it to the camera list. Click Add network 

camera button  and fill out the form. 

          

 

If you don t know a manufacturer or a model of the camera, leave the value Unknown in the 
drop-down list. After you enter all information about your camera press Test & Save button and 
the connection to the network camera will be tested. 

I f the test was not successful you are recommended to get back and edit the camera. For that 
press Back to edit button. 

To delete a network camera from the camera list click Delete network camera button . Or you 
can just deselect the camera to stop viewing it. 

You may switch the view from one camera to the other or view all cameras simultaneously. Use 
buttons on the top of the camera view area or just click on the image from the needed camera. 
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To view your video recordings, click on the tab Recordings and select the date in the calendar. 
Then point the needed hour or the period in the hour in the timeline area. Red time intervals on 
the timeline represent a record period when a motion was detected and the blue ones represent 
the record period when there was no considerable motion. The grey intervals mean the time 
periods with no recording. 

 

After you select the period for playback, click the Play button. I f you select the whole hour; all 
record periods will be played one after another. 

You can also take a snapshot of your live camera or the recording at any moment. To do this click 
the button on the top right of the camera view area. 

3. Mobiscope Desktop settings 

To use Mobiscope more effectively you may tune it up. You may determine general options of the 
application, camera and motion detector settings and record schedule. 

 

Mobiscope Options 
You may change general Mobiscope options. To open the window select the menu item Options 
in the File menu. 

You can select interface language, Mobiscope startup mode, connection settings and others. 

Note: Pay attention to the Video storage settings. All recordings have a one week storage interval by 
default. When it expires they will be deleted from Mobiscope Desktop! 

To change the password for camera access from your mobile device, select Password change 
section. 

In Sound settings section you may select a microphone device to transmit sound to the mobile 
device. You can get to know if the selected microphone is connected properly by watching the 
changes of a current volume bar. To turn ON and OFF noise reduction, use the corresponding 
checkbox. 

In Log section you may select to keep extended or detailed log. This may be useful if for some 
reason Mobiscope Desktop crashes or the camera hangs. 
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Camera Settings 
Change camera settings to get more distinct image from your web camera. 

  

Motion Detector Settings 
Determine the motion detection level to sift out the most important movements. You may also 
decide when the program must take action about the detected motion (every time the motion is 
detected or according to the schedule). 
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You may define up to three rectangular areas for motion detection. Otherwise the whole frame will 
be monitored for movement. 

The above settings are made for each camera. 

You may determine actions which Mobiscope will perform on motion detection (start recording, 
send alert by email). These settings are the same for all cameras. 

Note: Pay attention to the value of Turn Motion Detector on checkbox, please. It denotes when 
Mobiscope must take action about the detected motion. I f it is off (blue M) no actions will be taken except 
the scheduled ones! 

         

 

Email tab 

The picture of every motion will be included in the email by default. You may define how often the 
notifications should be sent. I f you want to decrease the number of email notifications you may 
select the longer time period in drop-down list. 

Note that the size of each email is limited to 200 Kb. That is why if a letter mounts to this limit it 
will be sent immediately and the setting Send alert not often than will be ignored. This may 
happen if you choose to attach full size pictures to the email and there are many movements. To 
decrease the size of emails you may select Only the first motion over the period to send 
checkbox. 

An email format may be chosen (HTML, Plain text). I f you want to receive notifications right on 
your BlackBerry, please select Plain text in the Format drop-down list. 
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Scheduler 

To use Mobiscope when it is needed you may add some schedule items. You may decide whether 
the video stream will be recorded continuously or the action will be taken only if a motion is 
detected. In the last case you may choose cameras which will be kept track by Mobiscope s Motion 
Detector. 

 

Note: A list of Mobiscope Desktop hotkeys is provided in Appendix B. Use it for acceleration of your work. 

4. Support 

You can find more information about Mobiscope on our site: www.mobiscope.com

 

If you need further assistance after reading this manual, please fill out our Support form:  
www.mobiscope.com/support

 

Our Support Team will answer your email within two business days. 
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Appendix A  Downloading Mobiscope Client 
Mobiscope Web client

 
Point any browser to web.mobiscope.com

 
Sign up for Mobiscope Web service and connect to your 

cameras. 

Mobiscope Web service is also available from Apple iPhone and iPod Touch at 
iphone.mobiscope.com

 
Sing in with your Mobiscope Web account. 

Mobiscope Client for Apple iPhone and iPod Touch

 

1. Go to App Store on your iPhone or iPod Touch and download Mobiscope. 

2. Find Mobiscope on iTunes Store

 

and download it to your computer. Then connect your 
iPhone or iPod Touch to the computer and iTunes will sync applications automatically. 

Mobiscope Client for Android device

 

Point the browser on your mobile to android.mobiscope.com

  

Sign up for Mobiscope for Android devices online service and connect to your cameras. 

Mobiscope Client for BlackBerry handheld

 

1. Point your BlackBerry browser to bb.mobiscope.com. Scroll down to highlight Download and 
select Get Link from the menu. Download the client and reboot your device. 

2. I f for some reason you can't download the client module directly, download Mobiscope Client 
(.zip file) from www.mobiscope.com/download to your computer. Unzip the file. 

Connect your BlackBerry to the computer. Run BlackBerry Desktop Manager on your computer, choose 
Application Loader, browse into a folder with mobiscope.alx file, select it and start the file uploading. 
The icon of Mobiscope application appears on your device. 

Mobiscope Client for Java-enabled phone and Symbian OS device

 

1. You can download the client directly to your mobile device. The WAP download location is: 
wap.mobiscope.com 

2. I f for some reason you can't download the client module directly, or error occurs at download, 
you can download Mobiscope Client (.zip file) from our site www.mobiscope.com/download

 

Mobiscope Client for Windows Mobile device

 

1. Download the client from wm.mobiscope.com directly to your mobile device and install it. 

2. I f for some reason you can't download the client module directly, download Mobiscope Client 
(.exe file) from www.mobiscope.com/download

 

to your computer. Connect your mobile 
device to the computer and start the program installation. (You need Microsoft ActiveSync to be 
installed on your computer. 

Mobiscope Client for Palm OS device

 

1. Download Mobiscope Client (.prc file) from www.mobiscope.com/download on your 
computer. 

2. Connect your mobile device to the computer and install Mobiscope using Palm Desktop or the 
other application for transferring files to Palm. 

Support

 

You can find more information about Mobiscope on our site: www.mobiscope.com

 

Support form for further assistance: www.mobiscope.com/support
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Appendix B  Mobiscope Desktop Hotkeys 

General 

Ctrl-Tab Move between tabs 

Esc Close a secondary window 

F12 Open Options window 

M Open Motion Detector settings window 

C Open Camera settings window 

S Open Scheduler window 

R Start/Stop recording 

Ctrl-S Take a snapshot 

Ctrl-N Add a new network camera 

Delete Delete the selected network camera 

1,2,3,4 View the 1st, 2nd, 3rd, 4th in a full-screen mode respectively 

` Multi-camera view 

Video recordings selection 

Home Go to the beginning of the cameras list or the recordings list 

End Go to the end of the cameras list or the recordings list 

Up, Down, Left, 
Right 

Select the a video fragment in the recordings list 

Player 

Space Play/Pause 

Z Stop 

Ctrl-Arrow Left Play the video recording back 

Ctrl-Arrow Right Play the video recording forward 

< Rewind back 

> Rewind forward 

Alt-1, Alt-2, Alt-3, 
Alt-4 

Set playback speed to x1 (normal), x4, x16, x64 respectively 
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